The information in this document is subject to change without notice and does not represent a commitment on the part of Native Instruments GmbH. The software described by this document is subject to a License Agreement and may not be copied to other media. No part of this publication may be copied, reproduced or otherwise transmitted or recorded, for any purpose, without prior written permission by Native Instruments GmbH, hereinafter referred to as Native Instruments. All product and company names are ™ or ® trademarks of their respective owners.

Getting Started guide written by: Benjamin Weiss, Nicolas Sidi
Edited by: Nicolas Sidi, Patryk Korman
Document Version: 1.0 (02/2010)
Product Version: 1.5 (02/2010)

Special thanks to the Beta Test Team, who were invaluable not just in tracking down bugs, but in making this a better product.
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.5</td>
<td>Mute &amp; Solo</td>
<td>31</td>
</tr>
<tr>
<td>4.5.1</td>
<td>Hardware</td>
<td>31</td>
</tr>
<tr>
<td>4.5.2</td>
<td>Software</td>
<td>31</td>
</tr>
<tr>
<td>5.1</td>
<td>Available FX</td>
<td>33</td>
</tr>
<tr>
<td>5.1.1</td>
<td>Dynamics</td>
<td>33</td>
</tr>
<tr>
<td>5.1.2</td>
<td>Filtering</td>
<td>34</td>
</tr>
<tr>
<td>5.1.3</td>
<td>Modulation</td>
<td>34</td>
</tr>
<tr>
<td>5.1.4</td>
<td>Spatial and Reverb</td>
<td>35</td>
</tr>
<tr>
<td>5.1.5</td>
<td>Delay</td>
<td>35</td>
</tr>
<tr>
<td>5.1.6</td>
<td>Distortion</td>
<td>36</td>
</tr>
<tr>
<td>5.2</td>
<td>Applying FX to a Sound</td>
<td>36</td>
</tr>
<tr>
<td>5.3</td>
<td>Applying FX to a Group</td>
<td>39</td>
</tr>
<tr>
<td>5.4</td>
<td>Master FX</td>
<td>41</td>
</tr>
<tr>
<td>5.5</td>
<td>Muting FX</td>
<td>42</td>
</tr>
<tr>
<td>5.6</td>
<td>Automating FX and Sampler Parameters</td>
<td>43</td>
</tr>
<tr>
<td>5.7</td>
<td>The Input Module and Advanced Routing</td>
<td>45</td>
</tr>
<tr>
<td>5.7.1</td>
<td>Applying an Effect to an External Audio Source</td>
<td>45</td>
</tr>
<tr>
<td>5.7.2</td>
<td>Setting Up a Send Effect</td>
<td>48</td>
</tr>
<tr>
<td>5.7.3</td>
<td>Routing Tips</td>
<td>50</td>
</tr>
<tr>
<td>6.1</td>
<td>Creating a Clip in the Arranger</td>
<td>51</td>
</tr>
<tr>
<td>6.2</td>
<td>Inserting and Deleting Scenes</td>
<td>53</td>
</tr>
<tr>
<td>6.3</td>
<td>Using the Loop Mode</td>
<td>54</td>
</tr>
<tr>
<td>7.1</td>
<td>Editing a Sample</td>
<td>57</td>
</tr>
<tr>
<td>7.2</td>
<td>Slicing a Sample</td>
<td>60</td>
</tr>
<tr>
<td>7.3</td>
<td>Mapping Samples</td>
<td>62</td>
</tr>
</tbody>
</table>
8  Managing Projects ........................................................................................................... 65
  8.1  Saving Sounds, Groups, Patterns and FX Presets ......................................................... 65
      8.1.1  Saving a Sound .................................................................................................. 65
      8.1.2  Saving a Group .................................................................................................. 66
      8.1.3  Saving a Pattern .................................................................................................. 66
      8.1.4  Saving an FX Preset .......................................................................................... 67
      8.1.5  Tagging your Files .............................................................................................. 67
  8.2  Exporting Audio ............................................................................................................ 69
9   Tips for Playing Live ........................................................................................................ 71
  9.1  Focus on the Hardware .................................................................................................. 71
  9.2  Check your CPU Power Before Playing ...................................................................... 71
  9.3  Name your Groups and Sounds ................................................................................... 71
  9.4  Use Mute & Solo and Scenes and Patterns with the Lock Function ......................... 72
  9.5  Use Note Repeat ......................................................................................................... 72
  9.6  Set Up your Own Multieffect Groups ........................................................................ 72
  9.7  Use a Limiter on your Master ..................................................................................... 72
  9.8  Hook Up your Other Gear and Sync it with MIDI Clock ........................................... 73
1 Welcome to MASCHINE!

Thank you for buying MASCHINE!

MASCHINE is essentially the synergy of the MASCHINE Controller hardware and the MASCHINE software combining the advantages of both worlds for making music, live as well as in the studio. The intuitive, hands-on qualities of a dedicated Instrument, the MASCHINE Controller, with the advanced editing features and the versatility of the MASCHINE software turn it into the creative center of your musical productions.

Creating beats is often not very intuitive with a computer, but using the MASCHINE Controller to do it makes it easy and fun. You can tap in freely with the Pads or use Note Repeat to jam along. Alternatively, build your beats utilizing the Step Sequencer just as in classic drum-machines.

Since you can integrate it in any DAW that supports VST, Audio Units or the RTAS – format with multiple instances, you can profit from its abilities in almost any software setup or use it as a stand-alone application. You can sample your own material, slice Loops and rearrange them easily.

However, MASCHINE is a lot more than an ordinary Groovebox or Sampler: It comes with a 7 Gigabyte large Library programmed and gathered by well known artists and a sophisticated, yet easy to use tag-based Browser to give you instant access to the sounds you are looking for.

You can also control your external MIDI Hardware and your Software with the MASCHINE Controller and customize the functions of the Pads, Encoders and Buttons to your needs, utilizing the Controller Editor Application. This is possible at the same time you are using the Stand Alone version or the plug-in.

We hope you enjoy the MASCHINE playground as much as we do. Now let’s get going!

The MASCHINE team at Native Instruments
2 Installation and Setup

2.1 What’s in the Box

1 After opening the MASCHINE package you will find the following:
2 The MASCHINE Controller
3 The Installer DVDs
4 This Getting Started Manual
5 The Service Center Quick Start Guide
6 USB cable
7 The Serial Number Card

2.2 The MASCHINE Documentation

2.2.1 About this Getting Started Manual
This section will introduce you to the signage and text highlighting used in this manual.

Special Formatting
This manual contains some elements that appear in a different font type. This distinctive formatting has been applied in order to let you recognize certain elements in the text at a glance:

Menu Item: Items from MASCHINE’s menus are printed in italics.

GUI Element: Elements from MASCHINE’s graphical user interface (GUI) are printed in SMALL CAPS. Consequently you will notice that this formatting has been applied to all names of knobs,
buttons and other elements that let you interact with the MASCHINE software, but not to the names that relate to the MASCHINE Controller’s rotary encoders, pads, etc.

2.2.2 Other Documentation
What you are holding in your hands right now is the Getting Started Manual that will give you a fast overview of MASCHINE’s main features and functions. For more in-depth information on all the topics not covered here, please refer to the MASCHINE Reference Manual that is available via the Native Instruments Service Center application. Alternatively, you can download the Reference Manual from the Update Manager on the Native Instruments Website:

http://www.native-instruments.com

You can use the MASCHINE Controller for controlling other MIDI-enabled software or external MIDI hardware. For all information on these functions, please refer to the Controller Editor Manual, located in the Documentation folder inside the Controller Editor installation folder.

2.3 Installing MASCHINE
This chapter will guide you through the MASCHINE installation procedure step by step. The installation includes all components of MASCHINE: the MASCHINE application, the sound library and the Controller Editor application.

2.3.1 Installing MASCHINE on Windows XP and Windows Vista

⚠️ Please make sure that your MASCHINE Controller is not connected during the installation procedure.

⚠️ If a warning message concerning the Windows Logo test appears during installation, there is no need to worry – just click “Continue” to proceed.

1. Place the installation Windows-specific DVD in your computer’s DVD-ROM drive.
2. Use Windows Explorer to browse the content of the DVD-ROM.
3. Double-click the installer file named “MASCHINE Setup.exe.”
4. Click “Next.”
To continue, you need to first accept the license agreement. After you have read the license agreement, check the corresponding checkbox and click “Next.”

To perform a complete installation, leave the Complete option checked and click “Next” to install all components to their default location. To deselect components or to install the MASCHINE application or sound library to an alternative location, select Custom. Then click “Next.”

The Setup program will lead you through the installation procedure. Please follow the onscreen instructions.

After the installation has been performed successfully, click “Finish.”

To install the MASCHINE Controller hardware driver, you need to connect the MASCHINE Controller to your computer now. On Windows Vista, the driver setup will finish automatically. On Windows XP, the following screen should appear:

Select “No, not this time” and click “Next.”

On the following screen select “Install software automatically” and click “Next.”

Now the MASCHINE Controller hardware driver installation will finish. After that you need to go through the same procedure in order to install the MASCHINE Controller USB driver.

### 2.3.2 Installing the MASCHINE Software on Mac OS X

Place the installation DVD-ROM in your computer’s DVD-ROM drive. Its icon will appear in the Mac OS X Finder.

Double-click the MASCHINE DVD icon to display the content of the DVD.

Double-click the installer file named “MASCHINE Installer.mpkg.”

Click “Continue” to proceed.

To continue, you need to first accept the license agreement. After you have read the license agreement, check the corresponding checkbox and click “Agree.” Then click “Continue” to proceed.
6. Select the hard disk onto which you would like to install MASCHINE. Please note that you can only install MASCHINE onto hard disks which contain a Mac OS X version that matches the system requirements. Hard disks without a suitable Mac OS X version on them will be flagged with a red Stop sign, and you cannot select them in the Installation Destination dialog. From Mac OS X 10.5 on, this screen will be skipped automatically.

7. Click “Continue.”

8. Select the elements you want to install (we recommend installing all elements, however if you know that you don’t need a certain element like a plug-in format, uncheck the checkbox next to it). If you want to install the Maschine Library contents to a custom location, e.g. to an external hard disk, click the folder icon in the “Location” column to open a dialog in which you can specify a destination for the installation.

   ! You cannot deselect the Service Center application because it is required for activating the MASCHINE software.

9. Click “Install” to continue. The Setup Program will lead you through the installation procedure. Please follow the onscreen instructions.

10. To finish the MASCHINE Controller hardware driver installation you need to restart your computer now.

### 2.4 Activating MASCHINE

When you start the MASCHINE software for the first time, you will be asked to activate MASCHINE using the Service Center. Please refer to the Service Center Quick Start Guide for all information on that matter.
2.5 Connecting the MASCHINE Controller

Connecting the MASCHINE Controller to your computer is easy: plug the USB cable (included in delivery) into the USB port on the back of the MASCHINE Controller, then connect the cable’s other end to one of the USB-ports of your computer.

If you have any MIDI equipment such as synthesizers, keyboards, drum machines or samplers, you may connect them to MASCHINEs MIDI In and MIDI Out ports.

On its rear panel, the MASCHINE Controller features a MIDI In and a MIDI Out port as well as a USB port that connects it to your computer. Use the Kensington Lock slot to lock your MASCHINE controller to something immobile and thus save it from being stolen.

1 MIDI Out
2 MIDI In
3 USB socket to connect to your computer.
4 Kensington Lock slot to lock your MASCHINE Controller to something immobile.

If you want to connect the MASCHINE Controller to a USB-hub instead, make sure that the hub has its own power supply - the MASCHINE Controller will not work on a passive (bus-powered) USB hub.
3 Overview

This chapter will introduce you to the MASCHINE Controller’s hardware elements and the MASCHINE Software’s user interface. Nearly all functions are available on both interfaces. If you need to look up a certain user interface element’s name, you can return to this chapter at any time for a refresher!

3.1 Hardware

The MASCHINE Hardware Controller

1  Step Mode / Instance Button
2  Control Mode / MIDI Button
3  Sampling Button
4. Browse / Modules Button
5. Page Buttons
6. Auto Write Button (F2)
7. Snap Button (F1)
8. Note Repeat / Tap Tempo Button
9. Master Encoders: Volume, Tempo and Swing
10. Group Buttons
11. Grid Button
12. Transport Buttons
13. Buttons 1-8
14. MASCHINE Displays
15. Knobs 1-8
16. Pads
17. Erase Button
18. Shift Button
19. Modifier Buttons

💡 If you own an older Hardware Controller, some of its Buttons might have a different name. In this document, we use the new names, followed by the older ones in brackets if necessary.
3.2 Software

The MASCHINE Software

1. Header
2. Browser
3. Arranger
4. Control Area
5. Pattern Editor
The Header

1  Menu Button
2  Browser Button
3  Display Area
4  Transport Controls
5  Connect Button
6  Audio Engine Button
7  CPU Meter
8  Volume Control
9  NI Logo

The Arranger

1  Play Mode Controls
2  Group Slots
3  Arranger Timeline
4  Clip Area
The Browser

1. Browser Mode Selector
2. File Type Selector
3. Tag Filter
4. Text Search Field
5. Search Result List
6. Tag Editor
7. Audition Controls
The Control Area

1 Master Tab
2 Group Tab
3 Sound Tab
4 Source Tab
5 FX1 Tab
6 FX2 Tab
7 Output Tab
8 Quick Browse Area
9 Page Selector
10 Parameter Pages, depending on the selected Tab and Page
The Pattern Editor

1. Step Editor View Switch
2. Dragger Icon
3. Step Editor
4. Piano Roll / Keyboard View Switch
5. Sampling View Switch
6. Sound Slots
7. Automation Lane
8. Automation View Switch
9. Edit Controls
10. Pattern Timeline
11. Pattern Slots
12. Pattern Length Controls
The Sampling Area

1  Record Tab
2  Edit Tab
3  Slice Tab
4  Mapping Tab
5  Trim Controls
6  Sample Loop Controls
7  Zone Envelope Controls
8  Info Bar
9  Sample Timeline
10 Sample View
11 Zoom Tool
12 Start Marker
13 End Marker
4  Creating a Pattern

In order to get you started with MASCHINE, let’s lay out a basic Pattern with some drums, a bassline and a melody. On the way, you will learn how to create Sounds and Groups and how to add Effects (FX) to them.

4.1  Finding Samples in the Browser

The Browser is your tool for managing, finding, tagging and categorizing Projects, Groups, Patterns, Sounds, FX and Samples. If you want to know more about the Browser’s capabilities, read the “Browser” chapter in the MASCHINE Reference Manual.

Hardware

1. On the MASCHINE Controller, press the Browse Button. In the Left Display, you will now be presented with a selection of choices.

2. Press the Button 4 above the Left Display to select the Sound Tab.

3. Turn Rotary Encoder 1 until the Filter on the Left Display turns to “Sample.” This indicates that only Samples will be displayed now in the right display.

4. Since we are looking for a bass drum, first turn Rotary Encoder 2 until the Bank entry is set to DRUMS. Turn Rotary Encoder 3 to select Type entry KICK, then turn Rotary Encoder 4 until the Subtype is set to SUB. Using the Right Display and Rotary Encoder 5 you can browse through all the bass drums now. With Button 8 you can now load the selected bass drum into your Sound Slot.

The Browser on the Hardware
Software

1. Click the **Browser Button** in the top row to show the Browser within the MASCHINE window (the button gets highlighted):

   ![Browser](image)

   Click the Browser Button to open the Browser.

2. We will start by finding a bass drum for our Pattern: In the top row of the Browser, click on **Lib** to select your library, then click the **Sample Icon** to get a list of all the available samples in the library. Now activate Prelisten by clicking the **Audition Button** (with the loudspeaker symbol on it) underneath the list:

   ![Sample List](image)

   A List of Samples in the Browser. Click the Audition Button to listen to the samples as you select them.

3. You can listen to the Samples by clicking on their names.
4. Since we want to find a bass drum first, type “kick” into the empty field above the list of Samples. As soon as you start typing, you will see the list below being updated to display Samples matching your query.

![Browser, displaying a list of Samples that belong to the Searchresult “kick.”](image)

→ Now you can listen to the available bass drums by clicking on their names in the list and choose one you like.

Searching Samples by their names is not the only way to access the MASCHINE Library: you can also use the Browser’s Tag Filter to narrow down your search using Tags.

### 4.2 Selecting Sounds and Creating a Group

Now that you know how to find a Sample, we will create a Group which contains up to 16 Sounds and up to 64 Patterns associated with it.

**Hardware**

On the MASCHINE Controller, you were just browsing through the Samples using Rotary Encoder 5. Found a bass drum that matches your taste? Okay, then load it by pressing Button 8 on your MASCHINE Controller. It will be loaded into the focussed Sound and thus be playable by hitting the respective Pad.
Software

1. In the Pattern Editor, select Sound 1 by clicking on it:

![A Group with Sound 1 selected](image)

2. In the Browser, double-click on the Sample you want to use, in this case the bass drum. The display will now show the name of the Sample instead of “Sound 1.” If you do not like the Sample’s name that is being displayed, you can always change it by double-clicking on the Sound Slot and typing in a new name. After you have loaded a Sample into Sound Slot 1, you will recognize that Pad 1 on your hardware is lit. This indicates that there is a sample assigned to Pad 1, so if you hit the pad, the bass drum sample will play.

In the same way you have just selected your bass drum, try to find some other drum sounds that make a good match: e.g. a clap, a snare drum, a hi-hat and maybe a rimshot, and put together your drumset by assigning Sound after Sound.

4.3 Creating Patterns

Now that you have assembled a nice drum kit, let’s record a Pattern with it.

4.3.1 Adjusting Quantization Using the Grid

The Step Grid property affects all Pattern editing actions, including quantization (“note snap”). The default setting is 1/16th, however you may use another one or disable the Step Grid completely.
Hardware

1. To change the Step Grid’s quantization settings, press and hold the Grid Button on the MASCHINE Controller; the Right Display will show you which Pad represents which Grid.

2. Select a Step Grid resolution by hitting the corresponding Pad.

   ► If you want to adjust the Pattern Grid (see section “Adjusting Pattern Length”), press Button 3; then select a Pattern Grid resolution by hitting the corresponding Pad.

Software

The area to the right of the Sound Slots is called Step Editor. To change the Grid of the Steps, select a new value from the Grid Menu:

4.3.2 Adjusting Pattern Length

Hardware

► To change the Pattern length, press the Pattern Button, then turn Rotary Encoder 1. Dialing to the right will extend the Pattern, dialing to the left will shorten it.

► To adjust the step width of the Pattern Length parameter (the so-called Pattern Grid), press and hold the Grid Button and press the Button 3 above the Left Display; the Right
Display will show you which Pad represents which Grid. Select a Pattern Grid resolution by hitting the corresponding Pad.

The Right Display showing the available Pattern Grids

Software

Adjusting the Pattern length

The Pattern length is represented by the highlighted area of the Pattern. To change the Pattern length, click in the Pattern Length Bar at the position you want your Pattern to end. The Pattern length will resize to the mouse click position, quantized to the Pattern Grid value. To change the step width that the Pattern length can be resized in, select another resolution from the Pattern Grid Menu.

4.3.3 Recording a Pattern with the MASCHINE Controller

Now that you have chosen the Grid, let’s get going with the Pattern, starting with some drums!

Recording live

The first possibility is to simply record some beats with the Pads: press the Play Button, then the Record Button to enable Record Mode. Now hit the Pads you want to record and listen
to what happens. The Metronome will help you to keep the time when recording in realtime. To activate the Metronome, hold down Shift and press Play. To deactivate the Metronome, hold Shift and press Play again. If you want to quantize your recording afterwards, hold the MASCHINE Controller’s Shift Button and press Pad 5 (Quantize). Your recording will be quantized according to the selected Grid.

First possibility of recording a Pattern: press PLAY & REC and then play some Pads!

4.3.4 Step Sequencer

If you are familiar with classic drum machines such as those made popular by a well-known Japanese company, you may want to program your Pattern using the Step Sequencer:

1. Hit the Pad with the Sound you want to record to select it.
2. Press the Step Button. Now you will see a light chasing through the Pads, starting from Pad 1, going up all four rows from left to right and ending at Pad 16. Each Pad now represents one step of a 16-step sequence: you can activate it by hitting the Pad once, lighting it up. If you hit it again, the step is gone. This way it’s easy to quickly put some drums togethTo switch to another Sound, use Buttons 5 and 6, located above the Right Display.

💡 There is an Undo function available that you can access from the MASCHINE Controller: hold the Shift Button and press Pad 1 to undo any pattern edits.

💡 Only the first 16 steps will be represented in the Step Sequencer, so if you want to program longer Patterns, you will have to switch to the next 16 steps by using Buttons 7 and 8.
4.3.5 Note Repeat

Another possibility is using Note Repeat. It is a really handy way to program beats: it plays the selected Sound automatically at a given quantization. While holding the Note Repeat Button, press the Pad you want to record: notes will now repeatedly triggered at the selected rate shown on the Right Display. With Buttons 5-8, you can select different quantization settings while playing. If you want to use quantization settings other than the ones currently on display, turn Rotary Encoders 5-8, selecting the desired quantizations.

4.3.6 Recording a Pattern with the Software

► In the MASCHINE Software, set a step by double-clicking into the Grid to the right of the respective Sound.
To clear the step, right-click (on Mac OS X: [Ctrl]+click) it. You may also drag it to the right or left, or stretch it by dragging its right border.

There is an Undo function available that you can access from the MASCHINE software's Edit menu or by pressing [Ctrl]/[Cmd]+[Z] on your computer keyboard.

4.4 Creating Patterns in the Piano Roll/Keyboard Mode

Okay, drums might not be all we need, so what about a melody or bassline now? Choose a tonal Sample in the way you chose a drum Sample as described in “Selecting Sounds and Creating a Group.” If you prefer to play your melodies with a MIDI keyboard, connect it to the MIDI In on the Hardware. You can also use any USB MIDI keyboard selected in the “Audio and MIDI Settings” window. The connected MIDI input device will always play the currently selected Sound.

Try to experiment with all kinds of Samples in the Piano Roll/Keyboard Mode; some rather boring sounding Samples can be really interesting if you play them very low or very high!

Hardware

1. Select your Sound by hitting the Pad it is assigned to.

2. Now press & hold the Pad Mode (Keyboard) Button. On the Left Display, you can choose the desired input mode. Press the Button 2 above the Left Display to select the Piano Roll/Keyboard mode; then release the Pad Mode (Keyboard) Button (you will notice that the Button stays slightly lit).
Activating the Piano Roll/Keyboard mode from the Hardware.

3. If you hit the Pads now, you will hear that they all play the same Sound, but with different pitches each. The pitch scale is divided in halftones, starting with Pad 1 as the lowest note going up to Pad 16 as the highest note.

4. Press the Play Button, then the Record Button, and start to record your melody!

Software

1. In order to select the Sound you want to record a melody with, click on its name.

2. Now click the Piano Roll/Keyboard Icon: the Grid that showed all Sounds of the Group in one row now only shows the Sound you selected: by adding steps, you can choose their pitch in halftones depending on where you put them, the lowest note being the lowest row in the Piano Roll/Keyboard Editor.

The Software view of the Piano Roll/Keyboard Editor

In the next chapter, you will learn how to add effects and get to know the powerful routing system of MASCHINE.
4.5 Mute & Solo

“Muting” is used to bypass the audio signal of either a Sound or a Group, whereas “Soloing” is pretty much the opposite: it mutes all other Sounds and Groups, so that you can listen to the selected Sound or Group alone. The combination of both is a useful means to play live and to test different sequences together.

4.5.1 Hardware

Solo
Press the Solo Button and hold it: now you can solo Sounds by hitting their Pads, and Groups by hitting the corresponding Group Buttons. Solo is a temporary mode, therefore you will have to hold the Solo Button to access it. If you press Solo and Button 1 at the same time, the Solo function gets locked, e.g. you stay in Solo Mode until you press Solo again.

Mute
Mute works in the same way as the Solo Mode: hold the Mute Button to mute Sounds by pressing their respective Pads, and Groups by pressing the Group Buttons. You can also lock Mute by pressing Button 1 at the same time and unlock it by pressing Mute again.

4.5.2 Software

Solo
► To solo a Sound, right-click (on Mac OS X: [Ctrl]+click) on the Pad icon in the Pattern Editor:

Soloing the Kick 80sElectro Sound
To unsolo it, right-click (on Mac: [Ctrl]+click) on the Pad icon again.

To solo a Group, right-click (on Mac: [Ctrl]+click) on the Group icon in the Arranger:

Soloing a Group

To unsolo it, right-click (on Mac: [Ctrl]+click) on the Group icon again.

Mute

To mute a Sound, click on the Pad icon in the Pattern Editor:

Muting a Sound

To unmute the Sound, click on the Pad icon again.

To mute a Group, click on the Group icon in the Arranger:

Muting a Group

To unmute the Sound, click on the Group icon again.
5 Using Effects & Routing

Now that we have created the Pattern, let’s spice it up with some Effects. MASCHINE provides a healthy selection of 21 Effects (FX) that can be applied on Sounds, Groups and the Master, all as Insert Effects. By using the Routing System, Effects can also be applied to external Inputs and set up as Send Effects.

5.1 Available FX

The Effects cover a wide range of sonic possibilities; for an in-depth description of all Effects and their parameters, read the “Effects” chapter in the MASCHINE Reference Manual. MASCHINE FX are really designed to be modulated! That’s when the sounds really come to life—when you start recording the knob movements. How to do that is described in section 5.6 “Automating FX and Sampler Parameters.”

5.1.1 Dynamics

Compressor
Classic compression effect to control the dynamic information of an audio signal.

Gate
The Gate cuts parts of the input signal which fall below the input threshold. This can be used to rhythmically chop the signal and make it sound more “punchy.”

Limiter
The Limiter ensures that the signal level stays below 0 dB, thus preventing digital clipping. It is recommended to place the Limiter in the Master FX slot. The Limiter can also increase the perceived overall perceived volume by reducing the threshold. Note that the Limiter introduces a small latency.
Maximizer
The Maximizer reduces the dynamics within the sound, making the overall sound louder.

5.1.2 Filtering

EQ
Use the EQ to boost or cut selective frequencies of the audio signal.

Filter
Filter with selectable characteristics that can be modulated via LFO or envelope follower.

5.1.3 Modulation

Chorus
The Chorus is useful to “thicken” signals and enhance the stereo content. It is most effective on melodic sounds.

Flanger
Standard Flanger with LFO and envelope-follower modulators.

FM
FM modulates the frequency of the audio signal based on FM synthesis. High frequency settings are useful for adding a subtle “gritty” texture to the input signal.

Freq Shifter
The Frequency Shifter allows for shifting selected frequencies of the audio signal.

Phaser
Standard Phaser with LFO and envelope-follower modulators.
5.1.4 Spatial and Reverb

Ice
Ice includes a bank of self-oscillating filters for interesting and colorful effects.

Metaverb
Like the Reverb, the Metaverb adds spacial room information. However, in contrast to the Reverb it has a much more “synthetic” sound, which is particularly suited to melodic content.

Reflex
At moderate settings the Reflex can be useful to emulate small, “tight” rooms. At more extreme settings, it can produce interesting artificial, metallic textures.

Reverb
The Reverb adds room information to the signal, making it sound more spacious and natural. It is particularly suited to drum sounds.

5.1.5 Delay

Beat Delay
The Beat Delay is a delay that is specialized for creating delays that are synced to the tempo.

Grain Delay
By chopping the input into small grains, the Grain Delay is useful for creating ambient textures. Increase Size, Space and Density to quickly transform any sound into an evolving ambient texture.

Resochord
The Resochord is a bank of 6 comb filters, each of which is individually tuned according to a particular chord. The Resochord will print its own harmonic content on to any input material.
5.1.6 Distortion

Distortion
Combining overdrive, feedback and modulation, the Distortion produces a heavy distortion/fuzz effect.

Lofi
The Lofi effect reduces the Bitrate and Sample Rate of the audio signal for an interesting “vintage” effect at subtle settings, and heavy digital distortion at extreme settings.

Saturator
The Saturator combines compression and saturation to increase the overall loudness and add additional harmonics. The Contour control determines how closely it responds to the input volume.

5.2 Applying FX to a Sound

You can apply two Effects directly to each of the Sounds of a Group.

Hardware
1. Press the Control Button to select the Control Mode.
2. Press Button 4 to put the focus on the Sound Tab which gets selected on the Left Display, then hit the Pad with the Sound you want to apply the Effect to.

On the Right Display, you can now see the Modules FX1 and FX2. Select FX1 by pressing Button 6.

The Right Display showing the Modules FX1 and FX2, with FX1 selected
3. To select an Effect for Module FX1, press Shift followed by Browse. The Right Display now shows the list of the available Effects.

![The Right Display showing a list of available Effects](image)

4. You can browse through the available Effects by turning Rotary Encoder 5. When you’ve found an Effect you want to apply, press Button 8 to load it into Module FX1. You can also use Buttons 5 and 6 to step through the list and load the FX directly.

**Software**

1. Click on the Sound Tab to select the Sound you want to apply Effects to. The actual Sound that you assign the FX to is always the one currently in focus; in the example underneath it’s the Noise FrostShock Sound.

![The Sound Tab with the Noise FrostShock Sound in focus](image)
2. Select one of the two FX Modules (in this case we select FX1) and click the Arrow to the right to get a list of all available FX:

![Dropdown menu of FX1 Module showing effects](image1)

The dropdown menu of the FX1 Module showing the Effects

3. As an example, let's choose the Reverb effect. After selecting it with the mouse, you will find the parameters displayed in the FX1 Module:

![Parameters of the Reverb](image2)

The parameters of the Reverb, ready to be tweaked

4. Now you can try out some of the parameters: turn the Size knob for a bigger Reverb or adjust the Stereo Width by using the Stereo knob.
5.3 Applying FX to a Group

You can apply two Effects directly to each Group. The Effects will then be applied to all the Sounds in the Group.

Hardware
1. In Control Mode, press Button 3 to put the focus on the Group Tab which gets selected on the Left Display, then press the Group Button of the Group you want to apply the Effect to.
2. On the Right Display, you can now see the Modules FX1 and FX2. Select FX1 by pressing Button 6.

Pressing Button 6 on the Right Display

3. To select an Effect for Module FX1, press Shift followed by Browse. The Right Display now shows the list of the available Effects.
4. You can browse through them by either turning Rotary Encoder 5, or by using Buttons 5 and 6.
5. When you’ve found an Effect you want to apply, press Button 8 to load it into Module FX1.

The Right Display showing the Load option

6. Switch back to Control Mode by pressing Browse again or pressing the Control Mode Button.
7. Now you can edit the Effect using the Rotary Encoders!
Software

1. Click on the Group Tab to switch to the Group level:

![The selected Group Tab](image1)

2. In the same way that FX get applied to the Sound currently in focus, they get applied to the Group currently in focus, so make sure to have your Group in focus in the Arranger:

![The Group in focus on the Arranger](image2)

3. Since our Group is mainly for drums, let’s apply some compression by adding the Compressor to the FX1 Module:

![The list of available Effects for the Group](image3)

4. Play around with the parameters of the Compressor to get used to it!
5.4 Master FX

You can apply two Effects to the Master so that all your Sounds and all your Groups together are being sent into the Effect.

Hardware

1. Press Button 2 to put the focus on the Master Tab which gets selected on the Left Display.
2. On the Right Display, you can now see Modules FX1 and FX2. Select FX1 by pressing Button 6.
3. To select an Effect for Module FX1, press Shift followed by Browse. The Right Display now shows the list of the available Effects.
4. You can browse through them by either turning Rotary Encoder 5, or by using Buttons 5 and 6.

The list of available Effects for the Master on the Right Display

5. When you’ve found an Effect you want to apply, press Button 8 to load it into Module FX1.
6. Switch back to Control Mode by pressing Browse Button again or pressing the Control Mode Button.
7. Let’s take the EQ here: use Rotary Encoders 1-8 to adjust the frequencies and get to know the EQ. By using the Page Buttons, you can access the other parameter pages, if any.

The parameters of the EQ on the Left and Right Display
Software
You might have realized now how this is going to start: first you select the Master Tab and then you click on the Arrow on the right of the FX1 Module to select an Effect for the Master. Since we want to fine-tune the frequencies of the Song, we choose here the EQ.

The list of available Effects for the Master

Use the mouse to turn the knobs on the EQ Module. By using the Page Selector, you can access the other parameter page(s), if any:

The Page Selector in the Software

5.5 Muting FX

Muting FX might come in handy whenever you want to return to a dry, unaltered signal: such as after applying so much Reverb that you can’t hear the dry signal anymore or to get rid of the Feedback while using the Delay for example.

Hardware
1. Depending on the Tab you used the Effect on, press either Button 2 (for the Master), Button 3 (for a Group + the Group Button) or Button 4 (for a Sound + the Pad containing the Sound).
2. Now the Right Display shows the FX Modules. To mute one of the FX, press Shift followed by either Button 6 (for FX1) or Button 7 (for FX2).

![The Right Display with FX1 and FX2 muted](image)

3. To unmute the FX, press Shift followed by the respective Button (6 or 7) again.

**Software**

1. Select the Tab where you want to mute the Effect (either Sound, Group or Master) by clicking on it.

2. Make sure you have the right Sound (click on it on the left of the Grid) or Group (click on it on the left of the Arranger) in focus. For the Master, select the Master Tab.

3. Now click on the label (orange if it is a Sound, blue if it is a Group, white if it is the Master) on the left side of the FX Modules to mute and unmute the desired Effect.

![Muting the Reverb](image)

### 5.6 Automating FX and Sampler Parameters

One of the really cool features of MASCHINE is the ability to automate parameters from the FX Modules and the Sampler Modules both on the Hardware and on the Software in a very easy way.
**Hardware**

► To automate a parameter with the Hardware, first make sure the song is playing, then simply turn one of the 8 Rotary Encoders while holding down the Auto Write (F2) Button.

→ Your automation gets recorded now.

► If you want to discard it and try again, press Erase, hold it and turn the Rotary Encoder again to delete the Automation of this parameter.

It is also possible to record Automation in the Step Sequencer:

1. Enter the Step Sequencer by pressing the Step Button.

2. Hold the Pad representing the Step you want to automate and turn one of the Rotary Encoders with the parameter you want to record Automation for.

**Software**

If you take a closer look at the knobs on the parameter pages you will notice they have an outer ring.

You can record Automation by moving that ring with a left click on it and then dragging it up and down.

To remove the Automation, simply right-click (on Mac: [Ctrl]+click) on that outer ring.
To edit the Automation, drag the automation points in the Automation Lane.

5.7 The Input Module and Advanced Routing

The Routing features allow for a flexible way to handle routings within MASCHINE and together with external instruments. Since the Routing capabilities are quite powerful, we will focus on two common usage scenarios: routing external audio into the FX and setting up Send FX. For more in-depth information, please read the “Routing” chapter of the MASCHINE Reference Manual.

5.7.1 Applying an Effect to an External Audio Source

Please make sure that you have connected an external audio signal source to your soundcard and that the inputs of the soundcard are activated.

1. Open Audio and Midi Settings from the File Menu.
2. Now activate the desired inputs by clicking on the fields on the right and selecting the desired physical input of your soundcard, then click OK.
Audio signals coming from external sources will now be routed to MASCHINE’s FX section!

Hardware
1. First choose an empty Group by selecting it with one of the Group Buttons.
2. Select an empty Sound Slot by pressing Button 4 and then one of the Pads, let’s say Pad 1.
4. By using Buttons 5 & 6 or Rotary Encoder 5 you can select between (NONE), SAMPLER, INPUT and MIDI OUT. Select INPUT and press Button 8 to confirm your selection.
5. Switch back to Control Mode by pressing Browse Button again or pressing the Control Mode Button.
6. You now can select your external source by turning Rotary Encoder 2. Then select effect slot FX1 by pressing Button 6.

7. Press Shift followed by Browse: now you see the list of the available Effects.

8. Choose an Effect and load it using Button 8. Now the external audio will be processed by the Effect.

Software
1. Choose an empty Group by selecting it in the Arranger, then choose one of the Sound Slots by clicking on it.

2. Select the Sound Tab and then click on the Source Tab (labelled “SRC”).

3. On the right of the Source Tab, you will find an Arrow. Click on it and you will be presented with three options in the dropdown menu: Sampler, Input and MIDI Out. Select Input.

4. You will now see two parameters: one knob for the Level of the external input and a Button that lets you select a Source. Select Ext In 1 as the Source.

5. Click on the FX1 Module next to the Input Module and select an Effect using the Effect Menu from the upper right corner of the FX1 Tab. Now the external audio will be processed by the Effect!
5.7.2 Setting Up a Send Effect

Sometimes you may want to have a classic Send Effect, for example a classic reverb which can be shared by multiple sound sources. This is how to set it up.

**Hardware**

1. Let's send the Snare of the 909 Kit to a Reverb Send Effect. Load the 909 Kit by double-clicking it in the Browser and create a basic Pattern.

2. Now select an empty Group with an empty Sound Slot, let's say Sound 1. Select it by pressing its Pad.

3. Press Button 5 to select the Source Tab (SRC). After that press Shift and Browse.

4. By using Buttons 5 & 6 or Rotary Encoder 5 you can select between SAMPLER, INPUT or MIDI OUT. Select INPUT and press Button 8 to confirm your selection.

5. To select an Effect Slot, press the Control Mode Button and then select FX1 by pressing Button 6.

6. Press Shift followed by Browse: now you see the list of the available Effects.

7. Select the Reverb, and load it using Button 8. Switch back to Control Mode by pressing Browse Button again or pressing the Control Mode Button.

8. Now get back to the 909 Kit Group and select the Snare Sound by pressing Pad 2.

9. Go to the Output Tab (OUT, Button 8) and turn Rotary Encoder 5 to select the Aux 1 destination: select Sound 1 from the list.

As you can hear, the Snare is already being sent to the Effect; by turning the Aux 1 Level, you can adjust the amount of signal that gets sent into the Reverb.
Software

1. Select the first Sound Slot of an empty Group. Load the Reverb into the Sound Slot’s FX Tab.

![Loading the Reverb](image1)

2. On the Source Tab (SRC), select *Input* and leave the Source at *Internal*:

![The SRC Tab set on Input](image2)

3. Now select the 909 Kit Group again and click the Output Tab (OUT) of the Sound Snare 909:

![The Output Tab](image3)
4. You can see the two Aux Sends, Aux 1 and Aux 2. In the dropdown menu of Aux 1, select *B: Input 1* to send the Snare 909 Sound to the Reverb in Sound 1:

Choosing Aux 1 Send

5. As you can hear, the Snare is already being sent to the Effect; by turning the Aux 1 Level, you can adjust the amount of signal that gets sent into the Reverb.

5.7.3 Routing Tips

- For a better overview, rename the Sound you use as a Send Effect after the Effects name.
- You can build your own multieffects this way: up to two FX per Sound with 16 Sounds per Group allow up to 32 different FX in one Group!
- Since you can save Patterns together with your Group, you can also prerecord automation for your FX, for example filter sweeps or complex FX clusters with multiple FX that you can use on your material.

The Routing in MASCHINE is a really powerful tool with a vast amount of possibilities. You can set up your own FX Chains, route Sounds through several other Sounds or out of your soundcard through a Hardware Effect and then back into MASCHINE. For more information on Routing read the “Routing” chapter of the Reference Manual.
6 Creating a Song Using Scenes

Creating a Song on MASCHINE is easy and straightforward. The basic concept is this: Groups and their Patterns are combined in Clips, a Clip being a representation of a Group with a specific Pattern. The Patterns are always named by their Bank and the Pattern number: A1 is the first Pattern of Bank A of the respective Group. A Song is divided into up to 64 Scenes; the Scenes are Parts of the Song containing different Groups and their Pattern content.

6.1 Creating a Clip in the Arranger

Each clip placed in the Arranger references one of the Patterns created in the Pattern Editor. Therefore, when the content or length of a Pattern is edited, all referencing clips in the Arranger will automatically get updated.

Hardware

1. Switch to Scene Mode by holding the Scene Button. The Right Display gives you an overview of the available Scenes. Hit Pad 1 to select Scene 1.
2. Enter Pattern Mode by pressing Pattern and lock it by pressing Button 1 at the same time.
3. Choose your Pattern by selecting it with the Pads. Again the Right Display gives you an overview of the available Patterns. The selected Pattern will automatically be inserted into the selected Scene.
5. By pressing Button 2, you can double the Pattern length with the same content.
6. By pressing Button 3, you duplicate the Pattern currently selected.
Software

1. Select the Scene you want to edit by clicking on the Scene Label in the Arranger Area.

![Selecting Scene 1](image)

2. Select the Pattern you want to use in the Scene by clicking on it in the Pattern Editor:

![Selecting Pattern A1](image)

3. A Clip, representing the selected Pattern, will be automatically inserted into the focused Scene Column in the Arranger.

![Creating a Clip](image)

► To delete a Clip, right-click (on Mac OS X: [Ctrl]+click) it.
6.2 Inserting and Deleting Scenes

Hardware
1. Enter Scene mode and lock it (press Scene and Button 1 at the same time).
2. Using Button 3 (Duplicate) you can now copy the Scene currently selected to the following Scene.

![Inserting a Scene]

4. To rearrange Scenes, use the Page Buttons at the left of the Displays.
   
   ![Editing options of a Scene]

   If there are already Scenes behind the one being copied, they will get shifted upwards one Scene number; respectively, if you delete a Scene, the following Scene will be shifted backward accordingly.

Software
1. Select the Scene you want to edit by clicking on it.
2. Now right-click (on Mac OS X: [Ctrl]+click) and you will be presented with a dropdown menu allowing you to cut, copy or paste the Scene’s content or to clear, remove or duplicate the Scene.

3. To rearrange Scenes, use the [Left] and [Right] arrows on your computer keyboard while holding [Ctrl] depressed.
6.3 Using the Loop Mode

A single selected Scene is always looping automatically. The Loop Mode allows you to select several consecutive Scenes and play them one after the other in a Loop. This is useful to check if the Scenes go well together and/or if the arrangement works.

Hardware
1. Enter Scene Mode by pressing the Scene Button and lock it by pressing Button 1 at the same time.
2. The loop range can be defined by selecting a start Scene and an end Scene. First, select the starting Scene by pressing the corresponding Pad. Then, while holding the first Pad, press the Pad corresponding to the end Scene.

Software
In Scene 1 click in the Arranger Timeline and drag to the right. The currently active Loop will be highlighted. Release the Mouse Button in Scene 2. Now you will hear Scene 1 and Scene 2 in sequence.

A Loop containing Scenes 1 and 2

Scene surfing: By toggling between Scenes you can find out if two Scenes are a good match, if you have to add another one or edit it. Since the Scenes always loop, there is no break that could disturb your inspiration! On the Hardware, press Scene together with Button 1 to lock it and use the Pads to change between Scenes; on the Software, click in the Scene row on the Scene you want to select.
7 Sampling

MASCHINE allows you to record internal or external audio signals using your soundcard. This is a useful feature if you want to record your own Samples or rearrange Loops that you have created yourself using MASCHINE.

Hardware
1. Choose an empty Sound Slot to record into by selecting it with its Pad.
2. Now hit the Sampling Button to enter the Sampling Mode:

   ![Record Page Display]

   The Record Pages on the Hardware Displays

3. You can select the Source by using Rotary Encoder 1: it is either set to “External” for audio signals connected to your audio interface, or “Internal” for audio signals from MASCHINE itself (either from another Group, Sound or from the Master Output).

4. In this case we record from the Group called 909 Kit, so dial Rotary Encoder 1 to select “Internal” followed by dialing Rotary Encoder 2 to select the 909 Kit Group.

5. There are two different ways to start a recording:
   - You can set a certain Threshold value, and the input signal level exceeding this Threshold will start the recording.
   - You can synchronize the recording function to the sequencer by selecting the Sync option, so that recording starts as soon as you start the sequencer.

Since we want to record a drumloop, we select “Sync” by dialing Rotary Encoder 3, and then define a length of 1 bar by turning Rotary Encoder 4.

6. Now hit Button 5 (Start) and, since the recording is going to be triggered by the sequencer, press Play.
7. After the recording is finished, the Right Display will show you the recorded Sample as a waveform.

8. If you record multiple Samples, you can navigate between them by Button 7 and Button 8. This is called the Recording History.

Software
1. First choose an empty Sound Slot to record into by clicking on its name.

2. Now click the SAMPLING Button right underneath the PIANO ROLL/KEYBOARD Button:

3. In the Record Tab, select your Source. You can record Samples internally (check the INT radio button) from another Group, Sound or the Master Output or from one of the External Inputs (check the radio button labeled EXT). In this case we will record from the Group called 909 Kit.

4. In the next Panel of the Record Tab, you can select a way to start the recording: either by setting a Threshold value (adjustable with the mouse by dragging) or in Sync with the Project Tempo. Since we want to record a drumloop from the 909 Kit, we select Sync.

5. Click on the Sync radio button and enter a length of 1 bar using the mouse and dragging:
6. Now hit Start and, since the recording is going to be triggered by the sequencer, Play.
7. After the recording stops, you will see the Waveform of your Sample:

![Image of Waveform]

The waveform of the recorded Sample

8. Under the bigger Waveform representing the recorded Sample, you can see a small icon for each Sample that got recorded into this Sound Slot: this is called the Recording History. You can drag the Samples to other Sound Slots to use them separately.

### 7.1 Editing a Sample

For external Samples coming from an instrument that is not synced to MASCHINE by way of MIDI Clock, it is more useful to record it manually or in Threshold Mode.

**Hardware**

With Button 2 you can reach the Edit Tab to edit the recorded Sample.

1. Change the Start and End point of the Sample with Rotary Encoder 1 and 2.
2. Enable Loop Mode by pressing the right Page Button to navigate to the second page and then turn Rotary Encoder 1.
3. Adjust the Start and End point of the Loop on the second page using Rotary Encoders 2 and 3.
The Edit Tab with a Loop

4. Since we recorded a drumloop in Sync, there is no need to adjust Start and End of the Sample or the Loop here, but we have to enable Loop as described above.

5. To focus on a specific part of the waveform, you can press & hold the Navigate Button and use the Rotary Encoders 5 and 6 to modify the zoom factor and the position in the waveform.

Software

1. In the Edit Tab, you can do the following: adjust Start and End of the Sample, enable the Loop Mode, adjust Start and End Points of the Loop, set a Crossfade and adjust the Attack and Decay of the envelope.

2. Select the Edit Tab by clicking on it.

3. Adjusting the Start and End point is done by either dragging the small grey icons labeled “S” (for Start) and “E” (for End) using the mouse, or by entering the Start and End points in their respective fields.
4. Since we recorded a drumloop in Sync, there is no need to adjust Start and End, but we have to enable Loop by clicking on the Enable radio button.

5. The Loop Area is now highlighted: you can change the Loop Area by moving the handles in the front and in the end of the Sample.

6. If you want to have a bigger view of what’s happening, put the mouse cursor over the timeline located above the waveform: the cursor turns into a small magnifying glass. Click and hold the mouse button, then drag your mouse vertically to zoom in/out and horizontally to scroll through the waveform. (You can also use the Magnifier Icon in the low left: Dragging it up zooms in on the waveform, zooming out is done by dragging it down.)
7.2 Slicing a Sample

Slicing a Sample is useful if you want to rearrange Loops or make them play correctly at another tempo. Let’s slice the drumloop we have just recorded!

Hardware

1. Press Button 3 to enter the Slice Tab.

   ![Slice Tab on Hardware](image)

   The Slice Tab on the Hardware

2. You can now see the Slices of the Sample represented by vertical lines in the waveform on the Right Display. As we know the tempo is identical to our Project tempo, we select Auto using Rotary Encoder 3.

3. There are three Slice Modes: “Split” slices the Sample into a predefined number of Slices, “Grid” slices the Sample into equally spread Slices with a predefined length, whereas “Detect” is detecting the Slices by identifying their transients according to a predefined sensitivity. Select the “Detect” entry by dialing Rotary Encoder 1.

4. Zoom in by pressing & holding the Navigate Button and using the Rotary Encoders 5 and 6 to modify the zoom factor and the position in the waveform.

5. Press Apply (Button 7) to slice the Sample. If you press Button 8 (Apply To), you can choose a different Sound or Group Slot to put the Slices on.

6. After that the display will automatically change to Keyboard/Piano Roll Mode. You can now play the Slices using the Pads.

7. If you change the tempo with the Tempo Encoder, you will hear the Loop changing its tempo accordingly. If you can hear little clicks and pops between the Slices, adjust the Sensitivity value using Rotary Encoder 2 and slice again.

   ❗ Using the “Apply To” function (Button 8) you can also select another Group to spread the first 16 Slices on its Pads.

  💡 Jam around with the Slices and see what you get: you can use Note Repeat to make them stutter or just rearrange them by hitting the Pads whenever you like.
Software

1. Click on the **SLICE** Tab.

![Image of the Slice Tab on the MASCHINE software]

The Slice Tab on the MASCHINE software

2. You can see that our Loop now has a couple of equally spread vertical lines in the waveform: this is where the Slices are going to be applied. As we know the tempo is identical to our Project tempo, click on **Auto** in the Control Area; the BPM value will remain unchanged.

3. Next, select **Detect** in the **Mode Menu** at the far left. This means that the Loop will be sliced according to the transients detected in the Sample (in contrast to slicing it into a specified number of Slices, or into Slices with a specified length). You will notice that the vertical lines have snapped to the transients.

4. Zoom in by clicking in the timeline above the waveform and dragging your mouse vertically (you can also use the **Magnifier Icon** in the low left of the Slicing Area), then adjust the Sensitivity by dragging up and down in the Slices field.

5. You can add or remove Slices manually by using the corresponding Buttons.
6. Now click on the APPLY Button to slice the currently selected Sample. Alternatively, click the Slice Dragger and drag it onto another Sound or Group Slot:

Dragging the sliced Sound onto a Sound Slot

7. The Piano Roll / Keyboard Editor will open automatically after that, and you will see a couple of notes:

The notes representing the Slices of a Loop

💡 Play around with the Slicing feature by removing some of these notes, quantizing or completely rearranging them!

These notes represent the Slices and trigger them in order to play the Loop just like we recorded it. Try changing the tempo now, and you will hear that the Loop automatically adjusts to the new tempo.

### 7.3 Mapping Samples

Since we sliced the Sample of our recorded drumloop already, we will not have to map it: the slicing algorithm already did that and also provided the notes for the Slices in the Piano Roll/Keyboard Editor.
However, mapping is useful for creating your own Sounds using multiple Samples instead of just one. In the Mapping Editor you can set a root note, a note range on the keyboard, velocity ranges and Tune, Gain and Pan for each Sample.

Hardware
1. In Sampling Mode, hit Button 4 to enter the Mapping Tab.
2. On the right display you will see the sample waveform of the selected zone now. To switch between the zones of a sound consisting of more than one Sample (Multisample Sound), use Button 7 and Button 8 for Previous and Next Zone.
3. To edit the velocity range of a Sample, switch to the next page using the Right Page Button: Rotary Encoder 1 and 2 are now used to define the lowest and the highest velocity.
4. The third page is used to enter Tune, Gain and Pan for the Sample Zone.
5. If you want to delete a Zone, select it and press Button 6 to remove it.

The Mapping Tab on the MASCHINE Controller

Software
1. Select an empty Sound Slot, then click the Sampling icon and enter the Mapping Tab by clicking on it:

Opening the Mapping Tab of the software
2. To add a new Sample, select one from the Browser and drag it into the mapping area. A Zone will be created; you can drag the left and the right border of the Zone with your mouse, thereby extending or minimizing it and defining a note range. The note range of several Zones can overlap.

3. You can also set all necessary parameters for a Zone in the Control Area: make sure the Zone is selected by clicking on it first though.

![Two Zones in the Mapping Tab](image)

→ Now you can set the selected Zone’s parameters:

1. Select a root note in the **Root** field.
2. Set the note range’s limits, using the **Low Note** and **High Note** fields.
3. Set the velocity range, using the **Low Vel** and **High Vel** fields.
4. Set the tuning in the **Tune** field.
5. Set the gain in the **Gain** field.
6. Set the panorama position in the **Pan** field.
8 Managing Projects

In this chapter we will show you how to use MASCHINE efficiently: you will learn how to save different elements of Projects independently so that you can easily use and find them for other Projects. These functions are only available in the MASCHINE Software. You will also learn how to export audio files from Groups, Sounds and the Master Output.

8.1 Saving Sounds, Groups, Patterns and FX Presets

8.1.1 Saving a Sound

To save a Sound, right-click (on Mac OS X: [Ctrl]+click) on the Sound Slot in the Arranger and select Save As… from the dropdown menu:
8.1.2 Saving a Group

To save a Group, right-click (on Mac OS X: [Ctrl]+click) on the Groups Slot in the Arranger and select Save As… from the dropdown menu:

![Saving a Group]

8.1.3 Saving a Pattern

To save a Pattern, right-click (on Mac OS X: [Ctrl]+click) on the Pattern Label in the Arranger and select Save As… from the dropdown menu:

![Saving a Pattern]
8.1.4 Saving an FX Preset

To save an FX Preset, click on the Arrow in the FX Module and select Save As... from the dropdown menu:

<table>
<thead>
<tr>
<th>(None)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compressor</td>
</tr>
<tr>
<td>Gate</td>
</tr>
<tr>
<td>Limiter</td>
</tr>
<tr>
<td>Maximizer</td>
</tr>
<tr>
<td>EQ</td>
</tr>
<tr>
<td>Filter</td>
</tr>
<tr>
<td>Chorus</td>
</tr>
<tr>
<td>Flanger</td>
</tr>
<tr>
<td>FM</td>
</tr>
<tr>
<td>Freq Shifter</td>
</tr>
<tr>
<td>Phaser</td>
</tr>
<tr>
<td>Ice</td>
</tr>
<tr>
<td>Metaverb</td>
</tr>
<tr>
<td>Reflex</td>
</tr>
<tr>
<td>Reverb</td>
</tr>
<tr>
<td>Beat Delay</td>
</tr>
<tr>
<td>Grain Delay</td>
</tr>
<tr>
<td>Resochord</td>
</tr>
<tr>
<td>Distortion</td>
</tr>
<tr>
<td>Lofi</td>
</tr>
<tr>
<td>Saturator</td>
</tr>
<tr>
<td>Open...</td>
</tr>
<tr>
<td>Save As...</td>
</tr>
</tbody>
</table>

Saving an FX Preset

8.1.5 Tagging your Files

As described in section 4.1 “Finding Samples in the Browser”, it is easy to find Samples and other MASCHINE file types with the Tag Filter of the MASCHINE Browser. To get the most out of this feature, you need to categorize your files with attributes, which are referred to as “Tags” in MASCHINE terminology.

1. To set Tags for a file, select the file from the Search Result List window and click on the Edit Button in the lower right corner of the Browser.
Select or deselect Tags from the Tag Lists in the Tag Editor Window by clicking on the Tag name. A File can have multiple Tags assigned to it.

You can add new Tags to the Tag Lists by clicking on the add new... entry at the end of each list. Type in a new Tag name and press enter to add it to the Tag List. The new entry will be automatically selected.

To assign the selected Tags to your file, click on the APPLY Button at the bottom of the Tag Editor Window.

Tags can be applied to a multiple selection of files. This is a useful feature after adding your own samples into the MASCHINE database. To select multiple files from the search result list window, click the file names while holding [Shift] or [Ctrl]/[Cmd] keys on your computer keyboard. [Ctrl]+[A]/[Cmd]+[A] can be used to select all entries.

It is easy to import your own sample collections to the MASCHINE database, without moving any files. Please refer to the Reference Manual to learn more about file import.
8.2 Exporting Audio

There are several ways to export audio files in MASCHINE:

1. From the File menu, select *Export Audio...*:

   ![Export Audio... command in the File menu]

   → The Export Window opens up.

2. In the Export Window’s *REGION* dropdown menu you can select the Region you want to export: all Scenes or the current Loop Range.

   ![Selecting the Region in the Export Window]

3. From the *OUTPUT* menu, select what you want to export: the *Master*, *Groups* or *Sounds*. If you select *Groups* or *Sounds*, a list of available Groups or Sounds will be displayed with a checkbox next to each entry: check all Groups or Sounds you wish to export.
Selecting the Output in the Export Window

4. In the **Folder** field, you can choose the destination folder of the exported audio.

5. In the Options section, you can additionally select a Bit Depth, enable Normalization and choose whether you wish to optimize the loop for looped playback (Loop Optimize).

6. When you are done, click on the **Export** Button at the bottom. To cancel, click on the **Close** Button instead.
9 Tips for Playing Live

Since MASCHINE is a very hands-on tool for producing music as well as for performing live, we figured we would gather some tips for you to get you started playing live. If you are used to playing live, you may not need them, but maybe you will find some new ideas to integrate in your set.

9.1 Focus on the Hardware

In a live situation it is not very comfortable or intuitive to look back and forth from your laptop screen running the MASCHINE Software to the MASCHINE Hardware.

9.2 Check your CPU Power Before Playing

Some things can be very embarrassing, for example if you are on stage and your computer starts to have hiccups because it cannot handle the amount of effects anymore. Although the MASCHINE Software is programmed very efficiently, this might happen if your computer is one of the older kind. So before you get on stage, give your live set a thorough performance check by first playing it at home.

9.3 Name your Groups and Sounds

Naming your Groups and Sounds gives you a better overview of exactly what you are doing, especially if you focus on playing with the MASCHINE Hardware. It might not be something that is very interesting, but it certainly pays off in a sometimes rather hectic live situation.
9.4 Use Mute & Solo and Scenes and Patterns with the Lock Function

Mute and Solo is a good way to build up a live set especially on MASCHINE as you can mute and solo Groups and Sounds at the same time. By locking the Mute and Solo function, you have both hands free to mute or solo Sounds and Groups. The same goes for Pattern and Scene Modes: Locking Modes is done by pressing Button 1 at the same time as the Mode Button, and unlocking by pressing Button 1 again.

9.5 Use Note Repeat

Note Repeat is a very useful tool for playing live: use it to add some additional drums, drop in some effect sounds, play a bassline or a melody.

9.6 Set Up your Own Multieffect Groups

As described in chapter 5.7 “The Input Module and Advanced Routing,” you can set up multieffect Groups containing all the Send Effects you want to use in a live set.

9.7 Use a Limiter on your Master

This sounds rather conservative, but if you want to avoid digital distortion caused by an overload of your soundcard, this is a useful safety measure.
9.8 Hook Up your Other Gear and Sync it with MIDI Clock

If you have other gear such as a drum machine, a synthesizer or another sequencer that is able to send MIDI Clock, hook it up to the MASCHINE Controller’s MIDI In and activate Sync to External MIDI Clock from MASCHINE’s File Menu so that they can play together in sync. MASCHINE can also receive MIDI Clock via an internal MIDI port, so you can synchronize it with a MIDI Master.